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Montana Department of Transportation - Control Diagrams and Abstracts in
Autodesk

Overview

This document contains the workflows necessary for creating control diagrams and
control abstract tables in Civil 3D.

Process Provenance

e Date of development: 6/5/2025

e Revision date: N/A

e Application/Tool(s): AutoCAD / Civil 3D

e Version(s): 13.6.1986.0 Civil 3D 2024.4.2 Update

e Environment(s): MDT Civil 3D State Kit r2024 v2.1.1
e Author: MDT EngOps Workflow Steering Committee

Statement of Need

Workflows specific to the creation of control and traverse diagrams were not covered in
the Civil 3D production training classes. For that reason, the Road Design Workflow
Subcommittee identified the need for documentation covering the topic.

Disclaimer: Because the State Kit is continuously being updated and improved, the
styles and layers in this documentation may vary from what is in the current version of
the State Kit.

Acronyms/Definitions Used in This Document

ACC — Autodesk Construction Cloud, Autodesk’s new cloud storage ecosystem with
enhanced tools, which will replace BIM 360 when it is retired

References

Coordinate System Settings Support Document

Import NAIP TIFF Imagery into Civil 3D
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Process Description and Examples
Sectionl. Control Diagrams and Control Abstracts
Procedure — File Setup

1. Create a new file using the design-start.dwt template. Save it as
<UPN>RDABS001.dwg to the RD directory of the project on BIM 360/ACC.

Civil 3D 2024

Open...

New

design-start.dwt

2. Assign the project’s coordinate system to the drawing according to the
Coordinate System Settings support document.

3. Change the drawing scale to 1" = 5000’ or 1" = 2000’ depending on the length of
the project. Long projects may require the 1” = 5000’ scale.

4. Inthe MDT Tools tab in the ribbon, select the MDT Sheet Layouts dropdown
from the MDT Sheets panel and select the Road Layouts button. Then shift
select the RD-Control-Diagram and RD-Control-Abstract layouts and click OK
to add them to the drawing.
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5. Follow the steps below to create a viewport in the newly created layouts:
a. Set the active layer to GS-VPRT.
® & 05 o [ GS-VPRT -

o g Make Current

i .5; Match Layer

b. Use the command VPORTS or use the Rectangular tool on the Layout
Tools contextual tab in the ribbon to create the viewport.

For the RD-Control-Diagram layout, select the upper left inside border of
the title block and create a rectangle that snaps to the bottom of the title
block, leaving paper space for the Control Diagram, Bearing Source, and
Level Datum Source blocks. This is ideal for projects that run south-north.

SHEET NO.
\ CONTROL DIAGRAM =

South-North project
potential viewport
limits

Department ofTrans ortaton

MONTANA
i

«
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For east-west projects, the viewport extents may need utilize either the

upper or lower half of the title block, using the midpoint of the title block,
like shown below:

CONTROL DIAGRAM e

LE.

AL

pifis
\ East-West project |

potential viewport

limits a|

: - l

ny

e
|

L e——

MONTA#A
i

|
| "\ x

For the RD-Control-Abstract layout, use the inner border limits of the title
block as the viewport extents.

\ CONTROL ABSTRACT M

it

AL

SEHHE

MONTANA
ot

N\
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6. Select the viewport border, then set the annotation scale of both viewports using
the Properties palette to match the drawing scale set in Step 3.

Mao
MNa
1" = 5000

8. Inthe Prospectortab in Toolspace, right click Data Shortcuts and Set the
Working Folder to the Project Files folder for the appropriate project. Right click
Data Shortcuts again and select Associate Project to Current Drawing.

9. Create a reference to the design alignment. Set the alignment style to MDT
ALGN-Plan CL and the alignment label set to MDT ALGN-Control Label Set
(500 Scale), then select OK.

Alignment style:

" MDT ALGN-Plan CL o [EShRE

Alignment layer:
| C-ALGN-GEOM-9555000RDALN-PROP-ML | 27

Alignment abel set:

@, MOT ALGN-Control Label Set (500 Scals)

Cancel Help

NOTE: The increment between major stations can be adjusted based on the
length of the project. Select the labels on the alignment, right click, and select
Edit Alignment Labels. Adjust the Increment value as necessary by double
clicking in the box and typing in a new value.

Type Style Increment
Major Stations  |MDT ALGN-Control Major Station  <7.4000.000"
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Procedure — Import Survey Control Points

1.

2.

3. Upload the file to the project's RD Folder on BIM 360/ACC.
4,

Download the X)XOOXXXXSUCONXXX.CSYV file from the SU or DI folder PCMS.

It may be necessary to download the DIGPAXXX.zip to find the file.

In the csv file, delete the column headers (if present) and ensure that the Raw
Description (fifth column contents) for all the points is listed as TRAV. If changes

were made to the file, save a copy of the csv, then close the file.

6029553
6039553
6049553
6059553
6069553
6079553
6089555
6099553
6109553
6119553
6129553
6139555

6ﬂ19555.

1244371
1245644
1245588
1247280
1248325
1248222
1250871
1250183
1252187
1253428
1254775
1256055
1255454

1552803
1552734
1554417
1553730
1555145
1555868
1555823
1357261
1557551
1558839
1538570
1558968
1558505

3553.74 TRAV
3564.44 TRAV
3548.61 TRAV
3558.15 TRAV
3598.35 TRAV
3594.97 TRAV
3585.04 TRAV
3564.89 TRAV
3540.59 TRAV
3497.93 TRAV
3533.13 TRAV
3533.81 TRAV
3552.63 TRAV

In Civil 3D, switch to model space, then select Points from File from the Import
panel in the Insert tab.

Control Diagrams and Control Abstracts
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5. In the Import Points dialog, specify the point file format to MDT - Point Name,
then select the green + and navigate to the csv on BIM 360/ACC. If necessary,
uncheck "Do elevation adjustment if possible" in the Advanced options section.
The Preview window will populate after selecting the file. Then select OK. The
points will populate in model space.

NOTE: It may be necessary to change the file type in Windows Explorer to
search for .csv instead of the default .txt file.

E Import Paints

x
Selected Files: 2
File Name Status
& C:\Users\u5451\DCVACCDo...  Matches selected point file for... b4

Spedify point file format (filkering OM):

EMZ {comma delimited)
1
| Autodes Uploadable File
MCT - Point Mumber

Preview: MOT - Point Name | 9555000CONT.csv

<

Mame Morthing Easting Point Elev...
5019555 1244370.... 1552803.... 3553.74
5029555 1245643.... 1552734.... 35%4.9449
5039555 1245588.... 1554417.... 3548.61

Raw Desc. "
TRAV

TRAV

TRAV W
>

Advanced options

Do coordinate

Do coordinate

[[] Add Points to Point Group.

nDo elevation adjustment if possible 3

tranzformation if possible

data expansion if possible

4

(4

Help

6. Drag overlapping labels away from one another to improve readability by
selecting a point and selecting the square grip to drag the label away from the

other point. The dragged state of the label will draw an arrow pointing to the
object.
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Procedure — Convert TXT to CSV

If the control data was not delivered as a csv, perform the following steps:
1. Download the Survey <UPN>DIGPAXXX.zip from PCMS and unzip the contents.

2. Create a new Excel file and save it as <UPN>SUCONXXX.CSV using the CSV
UTF-8 format to the RD folder on BIM 360/ACC.

3. Select the Data tab and select the From Text/CSV button.

File Home  Insert  Page Layout  Formulas

BRI B B R

Get From From From Tablef From Recent
Data ~ Text/CSV Web Range Picture ~ Sources

Get & Transform Data

4. Navigate to the xxxxxcontrol.txt (file name may vary) file within the DIGPA
folder and open the file.

The delimiter should default correctly. The format will likely be Tab. The preview
will show how it will be imported into the file. Change settings as necessary.
Then select Load.

o X
9555000control.txt
File Origin Delimiter Data Type Detection
1252: Western European (Windows) ~ Tab e Based on first 200 rows - [b'g
Columnl Column2 Column3 Columnd
6019555 1244370.922 1552803.005 3553.74 ~
6029555 1245643973 1552734.147 3564.44
6039555 1245588 471 1554417.113 354861
6049555 1247289 6595 15537303597 355815
6059555 1248325217 1555145486 3598.35
6069555 124522164 1555858.304 359457
6079555 1250870.597 | 1555823.219 3585.04
6089555 1250193051 | 1557260827 3564 89
6099555 1252186.991 1557550.597 3540.53
6109555 1253427959 1558838589 3497.33
6119555 1254775335 | 1558570.456 353313
6129555 1256058.671 1558968.035 3533.81
6139555 1255454094 1559504.774 355263
6149555 1256889.724 | 1561147.133 354861
6159555 1258337362 | 1560947.159 349534
6169555 1258232.326 1561765.837 348843
6179555 126129622 1561965.545 346022
6189555 1261579.445 15638994541 339132
6199555 1263477.726 1563380 289 339381
6209555 1263474.043 1564217.89 34432
o The data in the preview has been truncated due to size limits. W
. Transform Data Cancel
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6. Select the table and click the Quick Styles dropdown in the Table Styles group in
the ribbon. Then select Clear to remove the table formatting.

e

Table Styles

7. Click anywhere in the table, then select the Table Design contextual tab on the
ribbon and select Convert to Range from the Tools panel -or- right click the
table, then in the shortcut menu, click Table > Convert to Range. A warning will
pop up. Select OK to remove the query definition from the sheet.

Formulas Data Review View Acrobat  Power Pivot

E,

Insert
Slicer

Insert Automate

@ D Properties
_ =

Export Refres|

£33 Unlink

External Table Data

Page Layout Developer  Help Table Design

Summarize with PivotTable ~| Header Row First Column | Filter Button

E‘ Remove Duplicates Total Row Last Column

Banded Columns
Table Style Options

':% Convert to Range ~| Banded Rows

Tools

Table E‘i Totals Row

B Get Data from Table/Range...

Convert to Range

'Ltj MNew Comment External Data Properties...

1 New Note F Edit Query...

=1

8. The order for the columns should be as follows: point name, northing, easting,
elevation, description. Type TRAV in the fifth column for the description and copy
it down for all the points.

Columnl Column2 Column3 Columnd
6019555 1244370.922 1552803.005 3553.74|TRAV
6029555 1245643.973 1552734.147 3564.44| TRAV
6039555 1245588.471 1554417.113 3548.61|TRAV
6049555 1247289.695 1553730.397 J558.15| TRAV
6059555 1248325.217 1555145.4586 3598.35|TRAV
6069550 1248221.64 1555868.304 J594.97| TRAV
6079555 1250870.597 1555823.219 3585.04| TRAV
6089555 1250193.051 1557260.827 3564.89|TRAV

Control Diagrams and Control Abstracts
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9. Delete the column headers.
10. Delete the Sheet1 sheet in the workbook.

11. Save the file and close it.
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Procedure — Insert Imagery into Control Diagram

1. Set the active layer to X-IMAG-AERI and set the Transparency to 65 for the layer
using the Layer Properties Manager palette (Command: LAYER).

5. Mame 0. F.. L. P.. Color Linetype Lineweight Transparency M. Description

" X-IMAG-AERI ® @ = |l wh.. Continu.. —— 0.000" 65 . General: Image: Aerial
& ¥-IMAG-FDPL ® @ o = [l wh. Continu.. — 0.000" 0 I General: Image: Flood Plain

2. Select the Geolocation tab in the ribbon and set the Online Map to Map Aerial.

NOTE: For shorter projects, it may be better to import NAIP TIFF imagery
following the Import NAIP TIFF Imagery into Civil 3D tip document. The
Geolocation map is sufficient for large scale projects while TIFF imagery map is
preferable for shorter projects due to higher quality ground resolution.

3. After the map populates, select Capture Area from the Online Map panel in the
Geolocation tab. Draw a window around the extents of the project. Then turn the
map off. Once the map is turned off, only the clip will remain.

4. If necessary, adjust the resolution of the imagery by selecting the image, then
selecting the Fine or Very Fine from the resolution dropdown in the Map Image
contextual tab.

Optimal

Very Fine

Fine

Optimal
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Procedure — Set Up Control Diagram Layout

1.

Select the RD-Control-Diagram layout. Double click within the viewport to
activate it, then use either the Zoom Extents (Command: ZE) or Zoom Window
(Command: ZW) command to center the points within the viewport. If necessary,
adjust the size of the viewport to better match the size of the map image. When
complete, lock the viewport by selecting the viewport border in paper space and
selecting the lock icon in the Layout Viewports section of the Layout Tools
contextual tab.

In paper space, move the P-NorthArrow-Only block to the map, then use the
CHSPACE command to transfer the north arrow to model space.

Move the N-ControlAbstractNote and N-LevelData blocks as needed, then
double click the N-ControlAbstractNote block to edit the text in the note using
the Enhanced Attribute Editor. Utilize the Survey Control Readme
(<UPN>SURMEQ01.txt) file for the coordinate system and CSF information.

Explode the N-LevelData block. Type in the appropriate coordinate system and
NAVD 88 elevations according to the Survey Readme file.

NOTE: Survey prefers that the Montana State Plane Coordinate Zone as well as
the horizontal coordinates and geoid that were used in the survey are included in
the note.

SHEETNO.

CONTROL DIAGRAM l
%ig (A> SCALE: N/A
% © (g = ;Azi
% > A
v A E i
a, /Af‘/-; -
. S
=
' B Ry
L‘“i/</9~>
e
A

A,
i,
i,

—_—
"
MONTANA
Deparoment of Transporeation [z
i
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Procedure — Insert Control Abstract Table(s)

1. Select the RD-Control-Abstract layout. Double click within the viewport to enter
model space. In the Point Groups section in the Prospector, right click All
Points and then click Select.

B--‘i} [CLOUD]9555000RDTRV001_Doc

E"‘]% Paoints
B[‘ﬁ’] Point Groups

o [4] _

Q Surfaces Properties...
B-"1F Alignments Edit Points...
_,_.J' Feature Lines Lock Points
@ Sites Unlock Points
- ¥ Tumnouts and Crossovers Export Points...
‘E Catchments Delete Points...
- 31 Pipe Networks Apply Description Keys
Eﬂ Pressure Metworks
-k Bridges Copy..
B Corridors Show Changes...
DEE Assemblies Update
TR et

2. Inthe COGO Points contextual tab in the ribbon, select Add Tables from the
Tables panel.

Home  Insert  Annotate  Modify  Analyze View  Manage  Output  Surv

@ Properties .¢. .¢. @ Renumber
e 4 4 -
+ a Object Viewer ol " “: Datum
Add  Inguiry . Edit/List Point Group
Tables f8 Isolate Objects Points Properties @ Elevations from Surface

Tables General Tools - Madify

= Start 9555000RDTRV001 Doc® x
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3.

4.

In the Point Table Creation dialog, set the Table style to MDT Survey-(Control
Abstract). In the selection pane, select the check box next to MDT Point-Survey
(Control). Set the split table options to 25 rows per table and 2 tables per stack.
Select Across for Tile tables and Dynamic for Reactivity mode. Then select OK.

ﬂ Point Table Creation

Table style:

>

[, MDT Survey-{Cortrol Abstract)

o o+
v| R AR
o L

Table layer:

| X-MISC-TABL

N

Selection

Label Style Mame
&

Selection R...  Apply &

I <’{.L MDT Point-Survey (Control)

Add Existing

.
&

)

A7
[4‘?] Mo point groups selected,

JOERC

% Mo points selected.

split table

Maximum rows per table:
Maximum tables per stack:

Offset:

Behavior

Tile tables: (@) Across (CDown

Reactivity mode: O Static @ Dynamic

Cancel Help

[ 0.5000" |

If the viewport is centered on the points, pan to a location to the right of the
project so that the paper space is blank. Click a point on the left side of the
viewport within the model space to place the table(s). The table(s) will populate
after selecting a data point.
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5. Pan within the viewport to center the table(s), then lock the viewport.

NOTE: The annotation scale of the viewport must match the scale of the
drawing. If there are display issues, then use the command REA (REGENALL).

SHEET NO.
CONTROL ABSTRACT L
CONTROL ABSTRACT CONTROL ABSTRACT
POINT NORY EORX POINT POINT NORY EORX POINT ;
NAME/NUMBER | COORDINATE | COORDINATE | ELEVATION NAME/NUMBER | COORDINATE | COORDINATE | ELEVATION =
6019535 1244370922 1552603.005 355274 6269355 1269545.495 1571701.299 3408.72
i 6029555 1245643973 1552734 147 3564 44 6277625 1235381928 1546461933 3497 64
3+ 6039535 1243088 471 1954497113 334661 6279355 1271742.395 1073759.226 3375.16
6049555 1247289 695 1553730 397 3558 15 6267625 1234260 001 1547800 615 3459 80
6039535 1248325217 1555145486 359835 6269355 1272996.161 1574445.404 3381.28
6069555 1248221 640 1555868 304 3594 97 6297625 1236694 945 1548293 654 357711
6079935 1230670.997 1959823.219 308504 6299355 1271713.294 1073343.784 3376.40
6089555 1250193 051 1557260 827 3564 89 6307625 1237442 649 1547647 853 3586 21
6099555 1252186 991 1557550 397 354058 6309355 1272674354 1577048770 335008
6109555 1253427 969 1558838 589 349793 6317625 1238550 413 1550434 750 3551.80
6119935 1234773333 1958370436 353313 6327625 1240579.168 1030524.529 3548.35 g § g g
6129555 1256058 671 1558968 035 353381 6337625 1242143 635 1580565 991 3554 64
6139535 1255454 094 1558504 774 355263 6347625 1242995 537 1533135712 352568
6149555 1256889 724 1561147 133 3548 61 6399355 1273795705 1577547 270 335114 §
6159955 1258337 362 1560947 159 348594 6409355 1275236 581 1578463 862 3290 .80 g
5
6169555 1258232 326 1561765 837 348843 6418355 1275677 848 1580645 640 3282 12 E
6179555 1261296 220 1561963 345 3460 22 6429355 1275369 632 1581673619 3281.87
6189935 1261079.446 1963994941 3391.32 6439355 1277507.008 1082414.708 3292.26
n 6199555 1263477 726 1563360 289 3399 81
n 6209535 1263474049 1564217890 3449.20
6219555 1266514 469 1565023 097 344883
6229535 1266327.018 1066474281 3426.01
6239555 1268217 907 1566319022 3426 41
6249535 1268403295 1968201.722 340013
6239555 1270402 995 1570140 361 3409 44

6. Add the layouts to the project’s sheet set.
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